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Part	1:	CODA	System	User’s	Guide	
The	CODA™	Non-Invasive	Blood	Pressure	System	monitors	blood	pressure	in	mice,	rats,	gerbils	and	
other	small	animals	with	tails.	It	is	not	designed,	intended	or	authorized	for	use	in	human	applications.	
	
CODA	provides	the	highest	degree	of	accuracy,	versatility,	sensitivity	and	reproducibility	for	your	
studies.	Using	the	principle	of	Volume	Pressure	Recording	(VPR),	the	CODA	automatically	performs	
multiple	rapid,	simultaneous	measurements	of	six	physiological	parameters:	systolic	blood	pressure,	
diastolic	blood	pressure,	mean	pressure,	heart	rate,	tail	blood	flow	and	tail	blood	volume.	See	page	27	
for	more	about	types	of	blood	pressure	recording.		
	
The	Method		
An	occlusion	tail	cuff	is	inflated	to	impede	the	blood	flow	to	the	tail.	The	cuff	is	deflated	slowly	and	a	
second	tail	cuff,	incorporating	the	VPR	sensor,	measures	the	physiological	characteristics of	the	
returning	blood	flow.	As	the	blood	returns	to	the	tail,	the	VPR	sensor	cuff	measures	the	tail	swelling	that	
results	from	arterial	pulsations	from	the	blood	flow.	Systolic	blood	pressure	is	automatically	measured	
at	the	first	appearance	of	tail	swelling.	Diastolic	blood	pressure	is	automatically	measured	when	the	
increasing	rate	of	swelling	ceases	in	the	tail.	

System	Requirements	
To	run	the	CODA	Software,	you	will	need:		

£ a	computer	running	Windows®	7,	8	or	10—64	bit	with:	
§ 2.0GHz	or	higher	processor	
§ 2GB	RAM	
§ 2	USB	ports	
§ CD-ROM	
§ video	card	at	least	1024	x	768	resolution	
§ internet	connection	

£ a	CODA	Controller	connected	to	the	computer	by	USB	

£ a	mouse	or	touchpad	

£ at	least	one	of	these	CODA	Systems:	
§ CODA	Monitor		—		for	one	animal	at	a	time	
§ CODA	High	Throughput	—		for	2,	4,	6	or	8	animals	at	a	

time	
	
	

	 	

Our	email	newsletter	will	keep	you	up	to	date	on	any	software	updates.	Sign	up	at					
www.kentscientific.com	or	contact	Kent	Scientific	at	888-572-8887.	

NOTE	
This	Owner’s	Manual	is	
for	users	running	CODA	
software	and	using	a	
Coda	High	Throughput	
Controller.	
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Included	Equipment	
Your	CODA	System	will	include	different	equipment,	depending	upon	exactly	what	you	have	ordered.		
You	also	have	the	option	of	ordering	a	laptop	with	pre-installed	CODA	software	from	Kent	Scientific.		
	
CODA	Systems	include:	

£ High	Throughput	CODA	Controller	with	capability	of	up	to	8	Channels—1	

£ Power	supply—1	

£ CODA	Controller	stand—1	

£ Occlusion	Cuff	Kit(s)u—1	kit	of	2	cuffs	per	Channel	

£ VPR	Cuff	Kit(s)u—1	kit	of	at	least	1	cuff	per	Channel	

£ Cuff	replacement	bladdersuu—12	per	cuff	

£ Replacement	O-Rings	or	Caps—1	pair	per	cuff	

£ Rodent	Holdersuuu—1	per	Channel	

£ Animal	Warming	Platformuuuu—1	for	1	to	4	channels,	2	for	5	to	8	Channels	

£ CODA	Cover	–1	for	each	Animal	Warming	Platform	

£ Infrared	Thermometer—1	

	
	
	
	
   u Each	Cuff	Kit	will	be	sized	for	either	Mouse	or	Rat	according	to	your	order	specification.	
  uu See	page	38	for	Cuff	Testing	Instructions.	
 uuu Rodent	Holder	size	will	match	your	order	specification.	
uuuu Each	Animal	Warming	Platform	holds	up	to	4	animal	holders.	
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The	CODA	Controller	
These	pictures	show	the	CODA	High	Throughput	Controller.	
	
Front	Panel	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
Rear	Panel	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	

	
	
	
	
	 	

	Power	supply	connector	

	USB	port	for	computer	connection	

	Diagnostic	port	

	Power	On/Off	switch	

		Occlusion	cuff	port	connectors 

		VPR	cuff	port	connectors	
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Getting	Started	
Four	steps	are	required	to	prepare	your	CODA	System	for	use:	

Step	1:	Install	the	CODA	software.	See	instructions	below.	
Step	2:	Install	the	CODA	System	hardware.	See	page	5.	
Step	3:	Configure	your	experiment	using	the	CODA	software.	See	page	9.	
Step	4:	Connect	your	animals	to	the	CODA	System.	See	page	6.	

Before	you	begin	your	experiment,	we	recommend	training	your	animal	
to	use	the	holders	in	three	or	four	fifteen	minute	sessions.	

	
Step	1:	Install	the	CODA	Software	
To	install	your	CODA	software:	

1. Close	all	open	applications	on	your	PC.	

2. Insert	the	CODA	software	disk	into	the	CD	drive	of	your	PC.	

3. Navigate	to	the	CD	drive	and	run	setup.exe.	

4. Follow	the	on-screen	directions	to	install	your	CODA	software.	
If	your	PC	does	not	have	a	CD	drive,	please	call	Kent	Scientific.		
	

Regional	and	Language	Settings	
You	will	need	to	adjust	some	of	your	Regional	and	Language	settings	if	you	are	installing	the	
CODA	software	onto	a	computer	purchased	outside	the	United	States	or	if	you	see	this	or	a	
similar	error	during	installation:	
	
	
	
	
	
	
	

1. Open	the	Windows	Control	Panel	and	select	Regional and Language Options.		

2. At	the	Regional Options	tab,	select	the	language	setting	that	most	closely	matches	
your	location—for	example,	French (France)—and	click	Customize.	

3. In	both	the	Numbers	and	the	Currency	tabs,	set	Decimal Symbol	to	be	a	point	(.).		
	
	

	 	

For	additional	help,	refer	to	the	Quick	Start	Guide,	Cuff	Testing	Instructions	and	Calibration	
Verification	Instructions	in	the	Troubleshooting	section	beginning	on	page	35.		

Skip	Step	1	if…	
…you	have	purchased	
the	optional	laptop	from	
Kent	along	with	your	
CODA	System.	In	that	
case,	the	CODA	software	
is	already	installed.		
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Step	2:	Install	the	CODA	System	Hardware	
To	install	your	CODA	hardware:	

1. Choose	an	appropriate	location.	Proper	temperature	is	essential	for	accurate	NIBP	
measurements.	The	room	should	be	at	or	above	26°C.	A	room	that	is	too	cool	will	prevent	an	
animal	from	thermoregulating,	resulting	in	reduced	tail	blood	flow,	which	makes	accurate	
reading	difficult.	Keep	in	mind	that	cold	steel	tables	or	air	conditioning	vents	can	affect	room	
temperature.		

2. Plug	the	CODA	Controller	into	a	standard	wall	outlet.	

3. Connect	the	Controller	to	a	USB	port	of	your	computer.	

4. Remove	the	caps	from	the	Controller	VPR	ports	you	intend	to	use.	See	page	3.	They	should		be	
put	back	in	place	when	the	system	is	not	in	use.	

5. Attach	a	VPR	Cuff	to	each	VPR	port.	

6. Repeat	steps	4	and	5	for	the	O-Cuff	port(s).		

7. Power	the	Controller	on.	

8. Set	up	the	Animal	Warming	Platform	by	plugging	it	into	a	standard	wall	outlet.	This	will	cause	it	
to	come	on	automatically.		

	
Using	the	Animal	Warming	Platform	
Each	Animal	Warming	Platform	accommodates	up	to	four	animals.	Your	CODA	System	may	
include	one	or	two	Warming	Platforms,	depending	upon	the	size	of	your	Controller.	
	

Begin	warming	on	all	four	channels	by	pressing	the	START/STOP	button.	Press	it	again	to	stop	
warming.	All	controls	apply	to	all	four	channels;	channels	cannot	be	controlled	independently.	
	

The	Platform	will	turn	off	automatically	after	1	hour,	shown	as	1.0	in	the	time	selection	area.	Use	
the	UP	and	DOWN	buttons	on	the	right	side	of	the	
Platform	to	change	the	time	for	automatic	shut-off	in	
increments	of	half	an	hour.	The	available	range	is	0.0	to	
9.5	(zero	to	nine	and	a	half	hours).	Note	that	setting	the	
time	to	0.0	stops	warming	on	all	four	channels.		
	

Three	temperature	levels	are	available:	
§ Level	1	≅	32°C	
§ Level	2	≅	35°C	
§ Level	3	≅	38°C	

Note:	These	temperatures	are	approximate	and	depend	
upon	your	operating	environment.	

	 	

When	warming	is	active,	
the	green	LED	light	
associated	with	a	
channel	will	flash	when	
that	channel	reaches	
the	set	temperature.	
When	the	temperature	
of	a	channel	falls	below	
the	set	level	by	more	
that	0.5°C,	the	light	
glows	steadily	to	
indicate	that	warming	is	
active	again.	
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Step	3:	Configure	Your	Experiment	
The	CODA	software	will	lead	you	through	the	necessary	steps	to	configure	your	experiments.	See	Setting	
Up	and	Running	Experiments	beginning	on	page	9	for	details.		
	

Step	4:	Connect	Your	Animals	to	the	CODA	System	
Before	you	begin	your	experiment,	we	recommend	training	your	animal	to	use	the	holder	in	three	or	
four	fifteen	minute	sessions.	

1. Set	the	Animal	Warming	Platform	to	level	3	by	pressing	the	UP	
button	to	go	up	from	the	default	level	of	2.	

2. Temporarily	cover	the	Warming	Platform	with	the	CODA	Cover	
to	retain	the	warmth.	

3. Visually	inspect	all	cuff	bladders	and	replace	any	bladder	that	is	
starting	to	yellow	or	crack.		

4. Place	the	animal	in	the	holder,	if	you	are	using	it:	
i. Remove	the	rear	gate	of	the	animal	holder.		

ii. Slide	the	nose	cone	close	to	the	front	of	the	holder	and	tighten	the	thumb	nut.		

iii. Place	the	animal	into	the	holder.	Allow	the	animal	to	enter	the	holder	freely,	using	as	little	
force	as	possible	to	get	the	animal	into	the	holder.		

iv. Make	sure	that	the	tail	of	the	animal	extends	out	of	the	rear	of	the	holder.		

v. Replace	the	rear	gate	on	the	holder	and	tighten	the	thumb	nut.		

vi. Remove	the	Cover	from	the	Animal	Warming	Platform	and	place	the	animal	holder	in	the	V	
groove	on	the	Platform.		

vii. Adjust	the	nose	cone	so	that	the	animal’s	movement	is	limited	and	the	animal	appears	
comfortable.	Ensure	that	the	animal	cannot	turn	around	inside	the	holder	and	lock	the	
nose	cone	in	place	by	positioning	the	nut	in	the	groove.	

5. Place	the	cuffs	on	the	animal,	following	the	same	procedure	if	you	are	or	are	not	using	a	holder:	
i. Slide	the	Occlusion	Cuff	up	near	to	the	base	of	the	animal’s	tail.	It	should	slide	freely,	but	fit	

closely	when	not	pressurized.	If	you	encounter	resistance	while	sliding	the	cuff	up	the	tail,	
stop	and	do	not	force	the	cuff	further.	Forcing	the	cuff	will	only	compress	the	animal’s	
underlying	arteries	and	veins	resulting	in	poor	or	non-existent	blood	pressure	readings.	
Position	it	as	close	to	the	base	of	the	tail	as	possible	without	force.	

See	pictures	on	next	page.	

	 	

IMPORTANT	
When	you	use	the	holder,	
ensure	that	the	animal’s		
head	is	not	turned	and	its	
body	is	not	compressed	in	
any	way.	
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ii. Slide	the	VPR	cuff	up	the	tail,	with	the	larger	diameter	end	first,	until	you	reach	the	
Occlusion	Cuff.	If	you	feel	resistance	while	sliding	the	VPR	Cuff	up	the	tail,	do	not	force	it	
into	position.	Simply	use	a	cuff	one	size	larger.	Tail	swelling	can	be	sensed	on	any	part	of	
the	tail	as	long	as	there	is	a	sufficient	portion	of	the	tail	in	the	VPR	Cuff.	

																										 							 	
	
	

iii. Secure	the	Occlusion	Cuff	tubing	inside	the	groove	located	in	back	of	the	black	fastener	on	
top	of	the	holder.	This	will	assist	in	keeping	the	cuff	in	position.	To	maintain	the	position	of	
the	VPR	Cuff,	secure	the	VPR	Cuff	tubing	inside	the	groove	located	in	back	of	the	black	
fastener	on	top	of	the	holder.			

	

Before	you	start	measurements,	lift	the	CODA	cover	and	measure	the	animal’s	tail	temperature	by	
pointing	the	infrared	thermometer	at	the	tail’s	base.	The	temperature	should	be	between	32	and	35°C.	
Do	not	start	the	experiment	If	the	temperature	is	not	at	least	32°C.	Make	sure	the	entire	length	of	the	
animal’s	tail	rests	on	the	warming	surface.	You	can	use	the	CODA	Cover	over	the	tail	to	help	maintain	
optimal	temperature	for	measuring	blood	pressure.	
	
	

	
	 	

See	Replacing	a	Cuff	Bladder	on	page	17	for	information	about	changing	a	
leaking	bladder.		
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Using	the	CODA	Software	
	
Terminology	
The	CODA	Software	uses	these	terms:	

£ User	–	any	person	involved	in	CODA	experiments,	such	as	a	researcher	or	scientist	

£ Key User	–	the	main	person	associated	with	a	given	experiment	

£ Animal –	any	animal	associated	with	experiments	

£ Animal	Type –	the	sensitivity	level	of	an	animal,	either	Mouse	(higher)	or	Rat	(lower)	

£ Animal Group	–	a	group	of	individual	Animals	assigned	to	a	User	

£ Cycle	–a	single	performance	of	a	measurement		

£ Set		–	a	group	of	Cycles	in	the	same	Experiment	

£ Session — one	or	more	Sets	of	Cycles	in	a	single	Experiment	

£ Experiment		–		a	collection	of	Sessions	

	
User	Interface	
The	general	CODA	user	interface	will	be	familiar	to	Windows	users.	You	will	see	the	usual	menus,	icons,	
drop-down	lists,	dialog	boxes,	etc.	CODA	uses	a	variety	of	screen	styles	and	input	fields.	For	example,	In	
some	case,	you	choose	information	from	a	drop-down	box.	In	others,	you	type	directly	into	an	entry	
field.	The	User	and	Animal	Manager	uses	a	slightly	different	form	for	input:		
	

£ To	add	a	new	entry:	Click	 ,	then	type	in	the	pop-up	box.		

£ To	delete	an	entry:	Click	on	an	entry,	then	click	 .			

£ To	edit	an	entry:	Click	the	entry	twice	(do	not	double-click)	and	type	the	new	information.	

	
	
Arrow	Buttons	
Some	screens	contain	 	and	 	buttons.		

Use	these	buttons	to	select	items	from	a	list	by	click	an	item	from	the	list	on	the	left	and	clicking	 	to	
add	to	the	list	on	the	right.		

You	can	add	items	individually,	or	use Shift-click	or Ctrl-click	to	highlight	several	items	and	add	them	all	
with	one	 	click.	To	remove	items	from	the	list,	highlight	them	in	the	right-side	box	and	click	 .	
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Setting	Up	and	Running	Experiments	
To	run	an	experiment,	you	must	go	through	this	software	sequence:	

1. Select	the	CODA	device(s)	to	use.	
2. Create	or	add	to	your	lists	of	Users,	if	necessary. 
3. Create	the	Experiment	and	run	a	Session	of	that	Experiment.		Once	you	have	created	an	

experiment,	you	can	return	to	it	later	to	run	new	sessions.	
	

	
	

1. Select	CODA	Devices	
When	you	open	the	CODA	Software,	the	Device	Manager	appears.	Click	Use All Displayed Devices	to	
proceed	using	the	detected	CODA	device(s).	If	you	do	not	want	to	use	all	the	detected	devices,	highlight	
those	you	do	not	want	to	use	and	click	Remove.	To	change	your	selections	while	you	are	running	the	
CODA	software,	simply	open	the	Device	Manager	and	modify	your	choices.	
	
To	open	the	Device	Manager:		

Tools > Device Manager		
or	

		
	

For	more	information	about	using	the	Device	Manager,	see	page	24.	
	

2. Create	a	List	of	Users	and	Animals	
You	must	create	a	database	of	Users,	Animals	and	Animal Groups	for	your	Experiments.	You	will	be	selecting	
items	from	these	categories	for	each	individual	experiment	you	create.	Create	your	database	with	the	
User	and	Animal	Manager.	You	may	enter	the	information	for	your	upcoming	Experiment only	or	
information	that	you	plan	to	use	in	future	experiments	as	well.	
	

	 	

Running	Multiple	Experiments		
You	may	create	as	many	Experiments	as	you’d	like	and	open	Sessions	for	them	whenever	
you	need	to.	However,	only	one	Experiment	at	a	time	may	be	running		on	a	given	
Controller	and	in	a	given	instance	of	the	CODA	software.	Open	multiple	instances	of	the	
CODA	Software	to	run	multiple	Experiment	sessions	simultaneously,	assigning	the	
appropriate	CODA	Controllers	to	each	instance	of	the	software.	See	page	24	for	more.	
	

Important!	Click Save	or	Save & Close	after	any	addition,	edit	or	deletion	to	save	your	changes.	
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To	open	the	User	and	Animal	Manager:			
Tools > User and Animal Manager      

or	
		
	

	
	
There	are	three	tabs	in	the	User	and	Animal	Manager:		

£ Users:		Enter	the	names	of	any	Users	for	the	Experiment	you	
will	create.		

	

	

	

	

	

	

	

	

	

	

	

	

£ Animals:		Enter	the	Animals	for	your	Experiment	and	assign	them	to	an	Animal	Type,	which	is	a	
sensitivity	level,	either	Mouse	or	Rat.		

	

	

	

	

	

	

	

	

	 	

At	All	Tabs:	

• Click	 ,	then	type	to	
add.	

• Click	an	entry,	then	
	to	delete.	

• Click	an	entry	twice	
and	type	to	edit.	



	

	 11	

£ Animal	Groups:		Create	one	or	more	groupings	of	Animals	to	accommodate	the	way	your	Users	
are	associated	with	Animals for Experiments.	Specify	a	name	for	an	Animal Group	and	any	
descriptive	information	you'd	like.	A	dropdown	box	lets	you	assign	a	User	to	the	group.	Click	OK	
when	you	are	finished.	Make	sure	that	the	group	you	just	created	is	highlighted	before	you	
make	any	selections	from	the	list.		

	

	

	

	

	

	

	

	

	
	
	
	
	
The	CODA	software	requires	that	you	create	at	least	one	Animal Group.	You	can	put	all	your	
Animals	into	a	single	group,	or	you	can	break	your	animals	into	groupings	to	be	associated	with	
individual	Users.	An	individual	Animal	can	be	assigned	to	more	than	one	group	if	multiple	Users 
will	be	working	with	some	of	the	same	animals.	
	

	

	
	

3. Create	and	Run	an	Experiment			
Before	you	can	run	an	Experiment,	you	must	create	it,	giving	it	a	name	and	assigning	Users	and	Animals	
to	it.	Once	you	have	created	an	Experiment,	you	can	return	to	it	at	any	time	for	additional	sessions.	
	 	

About	Deleting	Users	or	Animals	
A	deleted	entry	that	has	never	been	part	of	any	CODA	experiment	is	removed	from	the	
database.		A	deleted	entry	that	has	been	part	of	an	experiment	is	marked	inactive	but	
remains	in	the	database	so	it	will	be	available	to	the	CODA	software	for	generating	reports.	
You	can	reactivate	a	deleted	entry	by	adding	it	again	with	the	same	name.	
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To	begin	creating	a	new	Experiment,	open	the	Experiment Wizard:		
File > New > Experiment 

or	
	
	

	
The	Experiment	Wizard	is	a	series	of	four	screens.	To	create	an	
Experiment	successfully	and	save	it,	you	must	enter	the	required	
information	on	all	four	screens	and	start	the	Experiment.	If	you	do	not	
end	the	Experiment	Wizard	by	pressing	Start	to	begin	a	running	your	
Experiment,	your	information	will	not	be	saved.		
	
Experiment	Wizard:	Screen	1	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

At	Screen	1	of	the	Experiment	Wizard:	
£ Name	your	Experiment.	

Type	any	combination	of	up	to	50	letters,	numbers,	symbols	and	spaces	in	the Experiment Name	
field.	

	
£ Assign	a	Key User.	

Choose	the	main	person	to	be	associated	with	the	Experiment from	the	dropdown	list	in	the Key 
User	field.	If	the	User	you	need	is	not	in	the	list,	click	Manage Users	to	open	the	Users	and	Animals	
Manager	and	add	the	name	you	need.	

	
£ Associate	any	other	personnel	with	the	Experiment.		

Select	names	from	the	shaded	box	under Additional Users	and	click	 	to	add	them	to	the	list.		
When	you	are	finished,	click	Next	for	the	second	screen	of	the	Experiment	Wizard.	
	 	

	

If	the	New	choice	of	the	
File	menu	is	grayed,	
check	that	your	CODA	
device	is	connected,	
turned	on	and	
communicating.	See	
page	24	for	more.	
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Experiment	Wizard	Screen	2	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
At	Screen	2	of	the	Experiment	Wizard:	

£ Name	your	Session.	
Type	any	combination	of	up	to	50	letters,	numbers,	symbols	and	spaces	in	the Session Name	field.	
	

£ Specify	details	about	the	Sets	and	Cycles	for	the	Session.	
A	Session	is	made	up	of	a	number	of	Sets	of	Cycles.	Indicate	how	many	Sets	make	up	the	Session,	
how	long	to	pause	between	Sets,	how	many	Cycles	make	up	each	Set,	how	long	to	pause	
between	Cycle,	and	how	many	Acclimation Cycles	to	run	at	the	beginning	of	the	Session.	Defaults:	
1	Set/Session,	30sec	between	Sets,	10	Cycles/Set,	5sec	between	Cycles,	5	Acclimation	Cycles	
	

£ Specify	Deflation Time	for	the	cuffs.	
Choose	the	number	of	seconds	of	deflation	during	which	measurements	will	be	made.	Default:	
15sec.		
	

£ Specify	Minimum	Volume.	
Minimum	Volume	is	the	smallest	volume	of	blood	that	will	cause	a	blood	pressure	reading	to	be	
made.	If	a	channel	registers	under	this	amount,	no	reading	will	be	made	at	that	channel.	
Default:	15ul	
	

£ Specify	Display	Style.		
Select	how	the	data	from	this	Session	will	be	presented	in	the	display	that	appears	while	your	
Experiment	is	running.	Choose	a	single	graph	for	each	device,	a	graph	for	each	channel	you	are	
using	or	a	text-only	display.	
	

When	you	are	finished,	Click	Next	for	the	third	screen	of	the	Experiment	Wizard.				
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Experiment	Wizard	Screen	3	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
At	Screen	3	of	the	Experiment	Wizard:	

£ Assign	individual	Animals	to	CODA	channels.	
Select	Animals	and	click		 	to	add	them	to	the	next	open	channel.		
	
You	can	choose	Animals	from	one	or	more	groups.	To	use	Animals,	either	in	addition	to	or	instead	
of	those	currently	listed	on	the	left	side	of	the	screen,	you	will	need	to	display	the	Animals	from	
one	or	more	additional	Animal Groups.	Begin	by	choosing	a	User	from	the	Select User	dropdown	
list.	Then	choose	a	group	associated	with	that	User.	A	list	of	any	unassigned	Animals	in	that	group	
will	appear.	Select	and	assign	individual	Animals	as	above.	
	
If	the	Animals	you	need	are	not	in	any	of	your	Animal	Groups,	click	Manage	Animals	to	open	the	User	
and	Animal	Manager	and	add	them.			
	

	
	
When	you	are	finished,	click	Next	for	the	fourth	screen	of	the	Experiment	Wizard.		
	 	

The	available	CODA	channels	are	those	you	have	selected	with	the	Device Manager.	The	
CODA	software	sequentially	numbers	the	channels	of	all	the	devices	you	have	said	you	
plan	to	use.	You	can	assign	only	one	Specimen	to	a	single	channel,	and	you	must	assign	
them	in	channel	order.	
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Experiment	Wizard	Screen	4	
		
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
At	Screen	4	of	the	Experiment	Wizard:	

£ Start	the	Experiment.		
§ Ensure	that	all	your	Animals	are	in	place.	See	Connect	Your	Animal	to	the	CODA	System	on	

page	6.		
§ Cap	off	any	unused	channels.	
§ Click	Start	to	start	making	measurements	and	collecting	data.		

	

	
	
	

While	Your	Experiment	Runs	
Once	your	Experiment	begins	running,	the	screen	will	display	real-time	data	about	your	measurements.	
This	can	either	be	in	the	form	of	a	graph	or	text,	depending	upon	how	you	have	set	up	your	Session.		
	
Along	the	top	of	the	screen	you	will	see:	

£ buttons	for	controlling	the	Cycle—Resume	and	Pause	on	the	left,	Stop and Close	on	the	right			

£ a	Show Log/Hide Log	button	

£ information	about	the	progress	of	your	Cycle	

£ a	Status Descriptions	button	that	shows	the	meaning	of	the	Status	messages	at	the	bottom	of	the	
screen	 	

IMPORTANT!			If	you	do	not	press	Start	at	this	screen,	your	setup	data	will	be	lost.	You	will	
have	to	create	this	Experiment	again	when	you	are	ready	to	run	it.	
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The	left	side	of	the	screen	displays	the	Run Log,	if	you	have	turned	it	on.	For	each	Cycle,	it	shows	you:	
£ the	type	of	Cycle—Acclimation Cycle	or	part	of	a	Set	

£ the	blood	pressure	for	each	Animal	

£ a	validity	code,	either	OK	or	an	error	code		

£ the	rate	and	volume	of	the	pressure	reading	(meaningful	only	if	the	validity	code	is	OK)	

The	current	Cycle	is	highlighted.	
	
	

Status	Codes	
Code	 Meaning	 Possible	Solution	

FAIL_TAIL_VOLUME	
Tail	volume	is	less	than	the	
minimum	acceptable	value	of	
15ul.	

Raise	tail	temperature	to	32°C	to	35°C	by	
increasing	the	warming	level	and	covering	the	tail.		

TOO_SHORT	 The	time	between	the	diastolic	
and	the	systolic	is	too	short.	

Ensure	animal	is	snug	in	the	holder	and	does	not	
have	room	to	move.	
Raise	tail	temperature	to	32°C	to	35°C	by	
increasing	the	warming	level	and	covering	the	tail.	

TOO_LONG	

The	time	between	the	diastolic	
and	the	systolic	is	too	long	to	
permit	more	than	one	set	on	the	
graph.	

Ensure	animal	is	snug	in	the	holder	and	does	not	
have	room	to	move.	

BAD_RANGE 
The	difference	between	the	
systolic	and	the	diastolic	is	less	
than	5.	

Ensure	that	the	equipment	is	in	a	quiet	area,	away	
from	any	causes	of	white	noise	or	vibrations—for	
example,	vibrating	electrical	equipment,	an	air	
vent	or	a	refrigeration	unit.	

WRONG_SHAPE The	diastolic	value	is	lower	than	
the	systolic.	

This	can	occur	from	any	of	the	causes	discussed	
above	for	the	other	Error	Codes.	

	
	
For	Graphical	Displays	
Each	pressure	trace	is	marked	with	the	points	at	which	systolic	and	diastolic	pressures	are	measured.	
The	O-Cuff	pressure	trace	is	displayed	for	reference.	
	
If	you	have	selected	a	graph	for	each	channel,	the	graphs	will	be	sized	to	allow	all	of	them	to	fit	on	the	
screen	at	the	same	time.	If	you	have	chosen	to	display	one	graph	for	all	channels	on	the	device,	a	legend	
will	identify	the	association	between	trace	color	and	channel.		
	
For	the	Text	Display	
Bright	colors	and	large	type	are	used	to	make	the	display	readable	from	a	distance.	Current	pressure,	
pulse,	volume	and	flow	appear	along	with	the	pressure	and	status	from	the	previous	Cycle.	In	addition,	
directly	under	the	current	pressure,	one	of	these	messages	appears:	 	
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• Prep—preparing	for	a	test	
• Acclimations—this	is	an	Acclimation	Cycle	
• OK—validation	status;	can	also	be	one	of	several	Error	Codes.	See	page	16.	

	
After	the	Session	is	complete,	a	report	appears	containing	the	details	of	each Cycle	of	the	Session.	You	
can	print	the	report	and	export	it	to	Excel.	See	page	21	for	information	about	this	Simple Report.	 
 

Monitoring	Experiments	
The	graphical	displays	provide	a	valuable	method	for	monitoring	
your	Experiments	for	potential	problems.		

• If	the	blue	line	drops	sharply	instead	of	gradually	at	the	
beginning	of	the	cycle,	you	probably	have	a	leak	in	the	VPR	
Cuff	bladder.		

• If	the	red	line	drops	precipitously,	you	probably	have	a	leak	in	the	O-Cuff.		
	
If	you	suspect	a	leak:	

• Pause	the	experiment,	change	the	bladder	in	the	cuff	with	the	suspected	leak	and	continue.		

• If	the	problem	persists,	pause	the	experiment,	remove	the	cuff,	place	the	white	cap	on	the	
channel	and	continue.	Then:	

§ If	the	display	line	returns	to	normal,	you	need	a	new	cuff.		

§ If	the	problem	persists	with	the	cap	on,	the	leak	is	internal.	In	that	case,	please	contact	Kent	
Scientific	immediately	for	customer	service.		

For	more	information,	see	Cuff	Testing	Instructions	on	page	38.		
 
Replacing	a	Cuff	Bladder	
Bladders	in	both	the	O-Cuffs	and	VPR	Cuffs	will	require	periodic	replacement.	Replacement	bladders	are	
included	with	your	CODA	System	and	more	are	available	by	request.	Use	only	fresh	Kent	Scientific	pre-
measured	cuff	bladder	replacements.	Other	materials	or	replacement	bladders	could	seriously	affect	
blood	pressure	readings.		
	

1. Remove	the	external	rubber	washers	(O-rings)	that	hold	the	bladder	on	the	cuff	at	each	end. 	

2. Slide	the	old	bladder	out	through	either	end	of	the	cuff	and	discard.	

3. Insert	the	new	bladder	inside	the	cuff.	

4. Fold	the	new	bladder	over	each	end	of	the	cuff.	

5. Secure	the	bladder	to	the	cuff	by	sliding	the	O-ring	over	the	ends	of	the	cuff	toward	the	middle	
of	the	cuff.	Be	careful	not	to	over	stretch	the	bladder	material.	

	
The	cuff	bladder	in	the	occlusion	cuff	should	be	wrinkle-free.	Ideally,	the	bladder	in	the	VPR	cuff	should	
be	loose	enough	to	not	hamper	the	expansion	of	the	tail	yet	still	allow	maximum	contact	with	the	
animal’s	tail.	Properly	installed	cuff	bladders	ensure	accurate	and	consistent	blood	pressure	
measurements.  

See	Sample	Displays	on	
page	18.	



	

	 18	

Sample Displays	 	

VPR	Cuff	Leaks		
Sample	display	showing	a	leaking	VPR	cuff.	The	top	
channel	shows	a	nearly	horizontal	blue	line,	
indicating	no	leak	in	the	VPR	cuff.	The	bottom	
channel	shows	a	sharp	drop	at	the	beginning	of	the	
cycle,	indicating	a	probable	VPR	cuff	leak.	Notice	the	
red	line	for	the	O-Cuff	drops	smoothly	indicating	no	
leak	in	the	O-Cuff.		

O-Cuff	Leaks		
Sample	display	for	O-Cuff	leak.	For	both	channels,	the	red	
line	drops	precipitously	at	the	beginning	of	the	cycle	
indicating	probable	O-Cuff	leaks.	Notice	that	the	blue	line	
for	the	VPR	cuff	remains	close	to	horizontal	indicating	no	
leak	in	the	VPR	cuff.	

O-Cuff	Tests	
Showing	Good	O-Cuff	 	 	 	 																	Showing	O-Cuff	Leak	
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Running	More	Sessions	of	an	Existing	Experiment	
Once	you	have	created	an	Experiment	and	have	run	one	Session	of	it,	you	can	return	to	the	Experiment	for	
additional	Sessions.	You	have	your	choice	of	starting	a	new	Session	with	settings	pre-filled	to	match	an	
existing	Session,	or	starting	from	scratch,	which	prefills	the	settings	with	the	default	values	only.	
	
To	begin	a	new	Session	of	an	existing	Experiment:	

File > New > Session 
or	

	
	

	
New	Session	Wizard:	Screen	1	

	 	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

At	Screen	1	of	the	New	Session	Wizard:	
£ Select	the	Experiment	you	want	to	continue	by	highlighting	an	existing	Experiment from	the	list.		

	
£ Decide	how	to	define	the	new	Session.	

• To	use	an	existing	Session	as	a	template	for	the	new	one,	highlight	a	Session	from	the	list,	click	
the	Use selected session as template	radio	button	and	click	Next.		

• To	reconfigure	the	new	session	from	scratch,	click	the	New setup	radio	button	and	click	Next.		
	
The	remaining	screens	of	the	New	Session	Wizard	look	just	like	those	of	the	Experiment	Wizard.	Name	
the	new	Session	and	specify	settings	for	Cycles,	Sets,	Acclimation Cycles,	Deflation Time,	Minimum Volume	and 
Display Style.	Then	click	Next	for	the	third	screen	and	assign	Animals	to	channels.		When	you	finish,	click	
Next	for	the	fourth	screen	to	begin	running	the	Session.		
	

	 	

Important!		If	you	do	not	press	Start	at	the	fourth	screen,	your	Session	setup	data	will	be	lost.	
You	will	have	to	create	this	Session	again	when	you	are	ready	to	run	it.	



	

	 20	

Part	2:	Software	Reference		
This	section	describes	the	function	of	each	CODA	menu	item	and	icon.		
	

File	Menu	
The	File	Menu	contains	four	choices:	New,	Open	and	Exit.	
	

£ File	>	New	>	Experiment			
Opens	the	Experiment	Wizard	
This	four-screen	wizard	leads	you	through	the	process	of	creating	a	new	Experiment	and	
beginning	to	run	it.	See	page	11	for	more.		
	

£ File	>	New	>	Session			
Opens	the	New	Session	Wizard	
This	four-screen	wizard	lets	you	design	and	run	a	new	Session	of	an	existing Experiment.	See	page	
19	for	more.		
	

£ File	>	Open				
Opens	the	Experiment	Manager	
The	Experiment	Manager	lets	you	view	information	and	reports	about	any	of	your	existing	
Experiments	and	add	comments.	You	can	also	delete	Cycles,	Sessions or	entire Experiments.		
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The	list	of	available	Experiments	and	Sessions	appears	on	the	left	side	of	the	screen.	Choose	the	
Experiment	and	Session	you	want	to	view.		
	
The	Experiment Information	box	at	the	top	left	of	the	display	area	shows	the	basic	experiment	
information.	In	the	Experiment Comments	field,	you	can	edit	existing	comments	or	add	new	ones.		
	
The	top	right	of	the	display	area	contains	Session Information.	None	of	it	can	be	edited.	
	
In	the	Measurement Information	section,	data	is	displayed	for	each	channel.	Click	any	heading,	such	
as	Diastolic	or	Channel, to	sort	by	that	item.	Check	or	uncheck	Regular Cycle	or	Accepted	to	change	
the	status	of	a	measurement.		
	
In	the	Measurement Display	area:	

• 		pages	through	the	Cycles	that	make	up	the	Session.	
	
• Save all images	saves	the	graphs	for	each	channel.	Choose	the	format	by	specifying	one	of	
the	listed	file	extensions,	such	as	jpg	or	png.		

	
• Delete Cycle	deletes	the	displayed	Cycle	permanently.	
	
• Simple Report	displays	a	report	summarizing	the	results	of	the	selected	Session.		

	

	

	

• There	is	one	line	of	data	for	each	Cycle	of	the	Session.		

§ Use	the	Columns	button	to	select	the	columns	you	would	like	displayed.		 	
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§ Click	on	a	column	header	and	drag	it	to	change	the	column	display	order.		

§ The	default	data	sorting	order	is	by	Animal.	You	can	choose	to	sort	by	any	other	
column(s)	as	well.	Double-click	on	a	particular	column	header	to	cycle	its	sort	setting	
through	none—ascending—descending—none.			

§ Print	opens	the	print	dialog	box.		

§ Export to Excel	exports	the	report	data	in	Excel	format	and	stores	it	in	the	location	you	
specify.		

 
• Full Report	displays	a	complete	report	for	the	selected	Session.	A	dialog	box	will	appear	at	
which	you	can	select	the	data	to	be	displayed.	Make	your	selections,	click	Finish	and	wait	
for	the	report	to	appear.		

	

	

	

	

	

	

	

	

	

	

	

	

	

The	screen	that	displays	the	report	contains	these	buttons	and	fields: 	

§   pages	through	the	displayed	Report.	

§   stops	the	report	before	it	is	fully	loaded.	

§   refreshes	the	Report.	

§   prints	the	Report.		

§   displays	the	Report	in	print	view.	Click	once	to	activate	and	again	to	return	to	
ordinary	screen	view.	
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§   opens	the	Page Setup	dialog	box.	

§   saves	the	Report	in	Excel,	PDF	or	Word	format.	

§   sets	the	zoom	level	for	viewing.	

§   searches	the	Report.	
	

	
At	the	bottom	of	the	Experiment	Manager	display	area	is	a	graph	displaying	all	channels	used	
during	the	current	Session.	Click	on	a	channel	in	the	Measurement Information	display	to	see	the	
graph	for	that	channel.		

	

• 	saves	the	current	graph	as	an	image	in	a	variety	of	formats	or	as	a	csv,	txt	or	xml	file.	

• 	 	copies	the	current	graph	to	the	clipboard	as	an	image.	

• 	copies	the	current	graph	to	the	clipboard	as	a	csv	file.	

• 	opens	the	current	graph	in	its	own	window.	

	

	
	

	
	

£ File	>	Exit	
Exits	the	CODA	Software.	

	 	

Important!	Be	sure	to	click Save	or	Save & Close	to	save	your	changes.	
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Tools	Menu	
The	Tools	menu	contains	four	choices: Device Manager, Experiment Manager,	User and Animal Manager,	and	
Backup/Restore.	
	

£ Tools	>	Device	Manager						
Opens	the	Device	Manager	
This	is	the	same	Device	Manager	that	opens	automatically	each	time	you	start	the	CODA	
Software.	You	can	open	it	at	any	time	to	test	your	CODA	devices	or	to	identify	and	use	another	
CODA	device.			

	
	
	
	
	
	
	
	
	
	
	
	
	

	
The	right	side	of	the	Device	Manager	displays	information	about	the	detected	CODA	hardware:		

• Channels	shows	how	many	channels	are	available	on	the	named	device	and	which	numbers	
have	been	assigned	to	those	channels.	Example:	Channels 1-6 (6)	means	there	are	six	total	
channels	available	on	this	device	and	they	will	be	called	channels	1	through	6.		

• SN	is	the	serial	number	of	the	device.	

• Version	is	the	version	number	of	the	device	firmware.	This	is	not	the	same	as	the	version	
number	of	the	CODA	software,	which	can	be	found	at	Help	>	About.		

• Communication Settings	shows	the	communications	protocol	(generally	Serial_Over_USB)	and	
port	used	by	the	driver,	along	with	the	baud	rate,	parity,	data	bits	and	stop	bits	of	the	
serial	port.		

• Run Parameters	lists	the	values	for	certain	CODA	run-time	parameters.	Generally,	these	are	
used	only	by	Kent	Scientific	if	there	is	a	need	to	diagnose	a	problem	with	the	system.	

Note:		If	you	are	running	more	than	one	instance	of	Coda	software,	each	of	your	devices	is	
available	to	one	instance	only.	If	an	active	instance	of	the	CODA	software	has	claimed	a	device,	
that	device	will	not	appear	in	the	display	of	the	Device	Manager	for	any	other	instance.		
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The	left	side	of	the	Device	Manager	contains	six	buttons:		
• Test opens	the	Device	Test	dialog	box	to	begin	the	process	of	testing	the	selected	device	for	
possible	system	leaks.	Highlight	one	device	from	those	listed	before	you	click	Test.	At	the	
Device Test	dialog	box,	check	the	appropriate	box	or	boxes	for	the	items	you	want	to	test:		
§ Ocuff Manifold	to	test	the	Occlusion	Cuff	Manifold	

§ Ch 1,	Ch 2,	etc	under	the	O	heading	to	test	the	Occlusion	Cuff	on	the	corresponding	
channel		

§ Ch 1,	Ch 2,	etc	under	the V heading	to	test	the	VPR	Cuff	on	the	corresponding	Channel	

You	can	specify	% Tolerance,	the	percent	deviation	in	pressure	values	that	will	define	
test	failure.	Click	Save	Tolerance	if	you	want	your	specified	value	to	replace	the	default	
value	of	5%	in	future	tests.		

	
During	each	test,	the	Device	Test	box	will	display	a	graph	of	pressure	against	time,	the	
name	of	the	current	test,	the	initial	and	final	pressure,	and	the	actual	percent	variation.	
All	test	results	are	logged	in	the	field	underneath	the	list	of	test	choices.	If	there	are	more	
results	than	fit	into	the	space,	a	scroll	bar	appears.	As	the	tests	progress,	either	a	check	
mark	for	success	or	an	x	for	failure	will	appear	in	the	box	next	to	each	test	you	have	
chosen.		
	

• Cancel test	stops	a	test	in	progress.	Close	the	dialog	box	with	the	x	in	the	upper	right	
corner.	For	more	about	interpreting	tests,	see	page	18.		

	
• Remove	removes	the	highlighted	device	from	the	list	of	devices	available	to	this	instance	of	
the	CODA	software.	A	removed	device	will	return	to	the	list	the	next	time	you	open	Device	
Manager	or	click	Search.	

	
• Search	searches	for	available	CODA	devices.	Any	time	you	add	or	remove	CODA	devices	
with	the	CODA	software	open,	click	Search	to	add	them	into	the	Device	Manager.		

	
• Identify	runs	a	brief	test	cycle	for	the	selected	device.	Highlight	one	device	from	those	
listed	before	you	click	Identify.	Before	a	device	cycles,	you	will	see	a	dialog	box	showing	the	
serial	number	of	the	device.	By	noting	which	device	cycles	next,	you	can	associate	a	serial	
number	with	it.	

	
• Use all displayed devices closes	the	Device	Manager	and	indicates	that	you	plan	to	use	the	
displayed	CODA	device(s).	

	
• Close	closes	the	Device	Manager	and	indicates	that	you	do	not	plan	to	use	any	of	the	
displayed	CODA	devices.	Use	the	red	x	in	the	upper	right	corner	of	the	Device	Manager	to	
close	with	no	changes,	that	is	with	the	same	CODA	device(s)	selected	as	were	selected	
when	you	opened	Device	Manager.	 	
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£ Tools	>	Experiment	Manager		
Opens	the	Experiment	Manager		
The	Experiment	Manager	lets	you	view	information	and	reports	about	any	of	your	existing	
Experiments	and	add	comments.	You	can	also	delete	Cycles,	Sessions or	entire Experiments.	For	a	
full	description,	see	File > Open	on	page	20.		

	
	
£ Tools	>	User	and	Animal	Manager					

Opens	the	User	and	Animal	Manager	
The	User	and	Animal	Manager	lets	you	create	a	database	of	people	and	animals	for	use	in	
setting	up	experiments.	For	a	full	description,	see	Create	a	List	of	Users	and	Animals	on	page	9.		

	
	
£ Tools	>	Backup/Restore	

Creates	CODA	backup	files	or	restores	CODA	data	from	a	previously	saved	version.		
This	selection	opens	the Backup/Restore	dialog	box,	which	contains	two	buttons:	

• Backup leads	to	a	box	at	which	you	select	the	location	for	your	backup	files.	Note	that	this	
will	create	a	large	number	of	files,	so	it	is	a	good	idea	to	save	each	backup	in	a	folder	of	its	
own.	

	
• Restore	leads	to	a	box	that	lets	you	choose	a	set	of	backup	files	to	be	restored.	This	will	
result	in	the	loss	of	any	data	currently	stored	by	CODA	and	will	replace	it	with	the	data	
from	your	backup.	It	cannot	be	undone.	If	you	want	to	look	at	a	past	saved	version	of	your	
CODA	data	without	losing	the	current	data,	back	up	the	current	data	first	(see	Backup 
above)	and	then	restore	the	older	version.	When	you	are	finished,	restore	the	last	backup	
you	made.		

	

Help	Menu	
£ Help	>	About	

Displays	information	about	your	CODA	version	
	

£ Help	>	Contents	
Opens	the	CODA	Help	document	
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Part	3:	Theory	of	Operation	
	

Concepts	of	Non-Invasive	Blood	Pressure:	Tail-Cuff	Method	
Over	the	past	35	years,	research	scientists	have	attempted	to	measure	blood	pressure	in	mice	and	rats	
non-invasively	with	varying	degrees	of	success.	The	ability	to	measure	systolic	and	diastolic	blood	
pressure	accurately	and	non-invasively,	in	addition	to	measuring	heart	rate	and	other	blood	flow	
parameters	in	rodents,	is	of	great	clinical	value	to	the	researcher.		
	
Invasive	Blood	Pressure	
Direct	blood	pressure,	an	invasive	surgical	procedure,	is	the	gold	standard	for	comparing	the	accuracy	of	
non-invasive	blood	pressure	technologies.	Direct	blood	pressure	should	be	obtained	on	the	rodent’s	
carotid	artery	for	comparing	to	non-invasive	blood	pressure.	“Validation	in	Awake	Rats	of	a	Tail	Cuff	
Method	for	Measuring	Systolic	Pressure”,	Bunag,	R.D.,	Journal	of	Applied	Physiology,	Vol	34,	Pgs	279-
282,	1973.	
	
Radiotelemetry,	a	highly	invasive	surgical	procedure,	is	a	very	reliable	blood	pressure	technology	and	is	
also	used	to	compare	the	accuracy	of	non-invasive	blood	pressure	technologies.	Telemetry	involves	the	
implantation	of	radio	transmitters	in	the	rodent’s	body.	This	technique	is	well	validated	and	has	
excellent	correlation	with	direct	blood	pressure.	The	advantage	of	implantable	radio	telemetry	is	the	
ability	to	continuously	measure	blood	pressure	in	free	moving	laboratory	animals.	
	
The	disadvantages	of	radiotelemetry	are:	(1)	morbidity	associated	with	the	initial	surgical	implantation	
of	the	transmitter;	(2)	morbidity	associated	with	surgery	required	to	replace	batteries	which	are	known	
to	be	short-lived;	(3)	increase	in	the	animal’s	level	of	stress,	especially	mice,	in	relationship	to	the	large,	
heavy	transmitters	(2004,	ATLA,	4thWorld	Congress,	Einstein,	Billing,	Singh	and	Chin);	(4)	abnormal	
behavior	due	to	the	animal’s	inability	to	have	social	interaction	stemming	from	the	current	technology’s	
requirement	for	the	implanted	animal	to	be	isolated,	one	animal	per	cage;	(5)	inability	to	perform	high	
throughput	screening;	(6)	high	cost	of	the	initial	equipment	set-up	and	of	the	transmitters	that	require	
frequent	factory	maintenance;	(7)	cost	of	material	and	human	resources	relating	to	ongoing	surgeries;	
and	(8)	the	lack	of	a	competitive	market	resulting	in	high	product	and	servicing	costs.	

	
	
Non-Invasive	Blood	Pressure	
The	non-invasive	blood	pressure	methodology	consists	of	using	a	tail-cuff	placed	on	the	tail	to	occlude	
the	blood	flow.	Upon	deflation	of	the	cuff,	one	of	several	types	of	non-invasive	blood	pressure	sensors,	
placed	distal	to	the	occlusion	cuff,	can	be	used	to	monitor	the	blood	pressure.	There	are	three	types	of	
non-invasive	blood	pressure	sensor	technologies:	photoplethysmography,	piezoplethysmography	and	
Volume	Pressure	Recording.	Each	method	uses	an	occlusion	tail-cuff	as	part	of	the	procedure.	
	
Photoplethysmography	
The	first	and	oldest	methodology	is	Photoplethysmography	(PPG),	a	light-based	technology.	The	
purpose	is	to	record	the	first	appearance	of	the	pulse	while	deflating	the	occlusion	cuff	or	the	
disappearance	of	pulses	upon	inflation	of	the	occlusion	cuff.	Photoplethysmography	uses	an		 	
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incandescent	or	LED	light	source	to	record	the	pulse	signal	wave.	This	light-based	plethysmographic	
method	uses	the	light	source	to	illuminate	a	small	spot	on	the	tail	and	attempts	to	record	the	pulse.	
	
Photoplethysmography	(PPG)	is	relatively	inaccurate	since	the	readings	are	based	solely	on	the	
amplitude	of	a	single	pulse	and	can	measure	only	imprecisely	the	systolic	blood	pressure	and	the	heart	
beat.	There	are	many	limitations	to	a	light-based	technology,	such	as:	(1)	over-saturation	of	the	blood	
pressure	signal	by	ambient	light;	(2)	extreme	sensitivity	to	the	rodent’s	movement	(motion	artifact);	and	
(3)	the	difficulty	in	obtaining	adequate	blood	pressure	signals	in	dark	skinned	rodents	(Pigmentation	
Differentiation).	Light-based	sensors	also	cause	tail	burns	from	close	contact	and	prolonged	exposure.	
Diastolic	blood	pressure	cannot	be	measured	by	photoplethysmography	since	the	technology	records	
only	the	first	appearance	of	the	pulse.	If	the	diastolic	blood	pressure	is	displayed	on	the	
photoplethysmographic	instrumentation,	it	is	only	an	estimation	that	is	calculated	by	a	software	
algorithm	rather	than	a	true	measurement.	
	
Additional	variability	and	inaccuracy	occurs	in	PPG	devices	that	rely	on	obtaining	blood	pressure	
readings	during	occlusion	cuff	inflation.	Occlusion	cuff	length	is	also	another	source	of	variability	and	
inaccuracy.	Occlusion	cuff	length	is	inversely	related	to	the	accuracy	of	the	blood	pressure.	Long	cuffs,	
predominant	in	most	photoplethysmographic	devices,	record	lower	than	the	actual	blood	pressure	
measurements.	
	
These	limitations	severely	compromise	the	consistency,	dependability	and	accuracy	of	the	non-invasive	
blood	pressure	measurements	obtained	by	devices	that	use	light-based/LED	photoplethysmographic	
technology.	
	
The	photoplethysmography	method	correlates	poorly	with	direct	blood	pressure	measurements	and	is	
the	least	recommended	sensor	technology	for	non-invasive	blood	pressure	in	rodents,	especially	mice.	
	
Piezoplethysmography	
The	second	non-invasive	blood	pressure	sensor	technology	is	piezoplethysmography.	Piezoplethys-
mography	and	photoplethysmography	require	the	same	first	appearance	of	a	pulse	in	the	tail	to	record	
the	systolic	blood	pressure	and	heart	rate.	
	
Both	plethysmographic	methods	have	similar	clinical	limitations.	Whereas	photoplethysmography	uses	a	
light	source	to	attempt	to	record	the	pulse	signal,	piezoplethysmography	uses	piezoelectric	ceramic	
crystals	to	do	the	same.	From	a	technical	point	of	view,	piezoplethysmography	is	far	more	sensitive	than	
photoplethysmography	since	the	signal	from	the	sensor	is	the	rate	of	change	of	the	pulse	rather	than	
just	the	pulse	amplitude.	Therefore,	even	extremely	small	mice	with	high	frequency	pulses	will	generate	
a	sufficient	signal	to	be	detected	with	simple	amplifiers.	
	
Piezoelectric	sensors	are	more	accurate	than	light-based/LED	sensors	but	the	same	plethysmographic	
limitations	continue	to	produce	inaccuracies	in	blood	pressure	measurements.	On	a	positive	note,	the	
skin	pigment	of	the	rodent	is	not	a	measurement	issue	with	piezoplethysmography	as	with	photo-
plethysmography.	
	
Although	piezoplethysmography	is	better	than	photoplethysmography,	both	non-invasive	tail-cuff	blood	
pressure	technologies	correlate	poorly	with	direct	blood	pressure	measurements.	
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Volume	Pressure	Recording	
The	third	sensor	technology	is	Volume	Pressure	Recording	(VPR),	the	technology	used	by	the	CODA	
System.	The	Volume	Pressure	Recording	sensor	uses	a	specially	designed	differential	pressure	
transducer	to	non-invasively	measure	the	blood	volume	in	the	tail.	Volume	Pressure	Recording	will	
actually	measure	six	blood-pressure	parameters	simultaneously:	systolic	blood	pressure,	diastolic	blood	
pressure,	mean	blood	pressure,	heart	pulse	rate,	tail	blood	volume	and	tail	blood	flow.	
	
Since	Volume	Pressure	Recording	uses	a	volumetric	method	to	measure	the	blood	flow	and	blood	
volume	in	the	tail,	there	are	no	measurement	artifacts	related	to	ambient	light.	Movement	artifact	is	
also	greatly	reduced.	In	addition,	Volume	Pressure	Recording	is	not	dependent	on	the	animal’s	skin	
pigmentation.	Dark-skinned	animals	have	no	negative	effect	on	Volume	Pressure	Recording	
measurements.	Very	small,	10-gram	C57/BL6	black	mice	are	easily	measured	by	the	Volume	Pressure	
Recording	method.	
	
Special	attention	is	afforded	to	the	length	of	the	occlusion	cuff	with	Volume	Pressure	Recording	in	order	
to	derive	the	most	accurate	blood	pressure	readings.	
	
Volume	Pressure	Recording	is	the	most	reliable,	consistent	and	accurate	method	to	non-invasively	
measure	the	blood	pressure	in	animals	ranging	from	mice	as	small	as	10	grams	to	rats	over	than	950	
grams.	
	
In	an	independent	clinical	validation	study	conducted	in	2003	at	Yale	University,	New	Haven,	
Connecticut,	Volume	Pressure	Recording	correlated	99	percent	with	direct	blood	pressure:	
“Volume	Pressure	Recording	is	excellent.	It	is	very	accurate	and	dependable.	We	performed	
experiments	on	temperature-controlled,	adult	rats	and	the	non-invasive	blood	pressure	measurements	
showed	almost	perfect	correlation	with	invasive	blood	pressure	measurements.	We	are	very	pleased	
with	the	results.”	
	
Numerous	published	research	papers	are	available	validating	the	accuracy,	reliability	and	consistency	of	
Volume	Pressure	Recording.	See	the	Clinical	Bibliography	section.	
	
Rodent	Holders	
The	ideal	animal	holder	should	comfortably	restrain	the	animal,	create	a	low-stress	environment	and	
allow	the	researcher	to	observe	the	animal’s	behavior	constantly.	A	trained	rat	or	mouse	can	
comfortably	and	quietly	remain	in	the	holder	for	several	hours.	
	
It	is	very	beneficial	to	incorporate	a	darkened	nose	cone	into	the	rodent	holder	to	limit	the	animal’s	
view	and	reduce	the	level	of	animal	stress.	The	animal’s	nose	will	protrude	through	the	front	of	the	nose	
cone	allowing	for	comfortable	breathing.	The	tail	of	the	animal	should	be	fully	extended	and	exit	
through	the	rear	hatch	opening	of	the	holder.	
	
The	correct	size	animal	holder	is	essential	for	proper	blood	pressure	measurements.	If	the	holder	is	too	
small	for	the	animal,	the	limited	lateral	space	will	not	allow	the	animal	to	breathe	in	a	relaxed	fashion.	
The	animal	will	compensate	by	elongating	its	body,	thereby	creating	a	breathing	artifact.	A	breathing	
artifact	will	cause	excessive	tail	motion	and	undesirable	blood	pressure	readings.	
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Animal	Body	Temperature	
A	non-invasive	blood	pressure	system	should	be	designed	to	comfortably	warm	the	animal,	reduce	the	
animal’s	stress	and	enhance	blood	flow	to	the	tail.	The	rodent’s	core	body	temperature	is	very	
important	for	accurate	and	consistent	blood	pressure	measurements.	The	animal	must	have	adequate	
blood	flow	in	the	tail	to	acquire	a	blood	pressure	signal.	Thermo-regulation	is	the	method	by	which	the	
animal	reduces	its	core	body	temperature,	dissipates	heat	through	its	tail	and	generates	tail	blood	flow.	
	
Anesthetized	animals	may	have	a	lower	body	temperature	than	awake	animals,	so	additional	care	must	
be	administered	to	maintain	the	animal’s	proper	core	body	temperature.	An	infrared	warming	blanket	
or	a	re-circulating	water	pump	with	a	warm	water	blanket	is	the	preferred	method	to	maintain	the	
animal’s	proper	core	body	temperature.	The	animal	should	be	warm	and	comfortable	but	never	hot.	
Extreme	care	must	be	exercised	never	to	overheat	the	animal.	
	
Warming	devices	such	as	hot	air	heating	chambers,	heat	lamps	or	heating	platforms	that	apply	direct	
heat	to	the	animal’s	feet	are	not	advisable	to	maintain	the	animal’s	core	body	temperature.	These	
heating	devices	will	overheat	the	animal	and	increase	the	animal’s	respiratory	rate,	thereby	increasing	
the	animal’s	stress	level.	These	conditions	will	elicit	poor	thermo-	regulatory	responses	and	create	
inconsistent	and	inaccurate	blood	pressure	readings.	
	
Environmental	Temperature	
The	proper	room	temperature	is	essential	for	accurate	blood	pressure	measurements.	The	room	
temperature	should	be	at	or	above	26°C.	If	the	room	temperature	is	too	cool,	such	as	below	22°C,	the	
animal	will	not	thermo-regulate,	tail	blood	flow	will	be	reduced	and	it	may	be	difficult	to	obtain	blood	
pressure	signals.	A	cold	steel	table	or	a	nearby	air	conditioning	duct	are	undesirable	during	animal	
testing. 	
	
Animal	Preparation	
The	animal	should	be	placed	in	the	holder	at	least	10	to	15	minutes	prior	to	obtaining	pressure	
measurements.	Acclimated	animals	should	provide	faster	BP	measurements	than	non-acclimated	
animals.	Proper	animal	handling	is	critical	to	consistent	and	accurate	blood	pressure	measurements.	A	
nervous,	stressed	animal	may	have	diminished	circulation	in	the	tail.	
	
Most	rodents	will	quickly	adapt	to	new	conditions	and	feel	comfortable	in	small,	dark	and	confined	
spaces.	Training	is	not	necessary	to	obtain	accurate	blood	pressure	readings,	however,	some	
researchers	prefer	training	sessions.	Rodents	can	easily	be	trained	in	approximately	three	days,	15-
minutes	each	day,	before	beginning	your	experiment.	
	
The	animal	should	be	allowed	to	enter	the	holder	freely.	After	the	animal	is	in	the	holder,	adjust	the	
nose	cone	so	the	animal	is	comfortable	but	not	able	to	move	excessively.	The	animal	should	never	have	
its	head	bent	sideways	or	its	body	compressed	against	the	back	hatch.	The	animal’s	temperature	may	be	
monitored	throughout	the	experiment.	
	
Conclusion	
Tail-cuff	non-invasive	blood	pressure	measurements	can	be	accurate,	consistent	and	reproducible	when	
studying	awake	and	anesthetized	mice	and	rats.	In	addition,	multiple	animal	testing	is	very	cost-effective		 	
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for	large	scale,	high	throughput	screening.	Care	must	be	exercised	to	properly	handle	the	animals.		
Training	the	animals	and	monitoring	the	animal’s	temperature	may	also	be	beneficial.	
	
The	volumetric	pressure	recording	method	provides	the	highest	degree	of	correlation	with	telemetry	
and	direct	blood	pressure	and	is	clearly	the	preferred	tail-cuff	sensor	technology.	
	
Non-invasive	blood	pressure	devices	that	utilize	Volume	Pressure	Recording	are	a	valuable	tool	in	
research	and	will	continue	to	be	beneficial	in	many	study	protocols.	The	main	advantages	are:	(1)	they	
require	no	surgery;	(2)	they	are	significantly	less	expensive	than	other	blood	pressure	equipment,	such	
as	telemetry;	(3)	they	can	screen	for	systolic	and	diastolic	BP	changes	over	time	in	large	numbers	of	
animals;	and	(4)	they	provide	the	researcher	with	the	ability	to	obtain	accurate	and	consistent	blood	
pressure	measurements	over	time	in	long-term	studies.	
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Part	4	–	General	Information	
Thank	you	for	purchasing	a	CODA	Non-Invasive	Blood	Pressure	(NIBP)	System.	We	truly	appreciate	your	business.	
We	strongly	advise	that	you	read	and	study	this	Owner’s	Manual	to	appreciate	fully	all	the	features,	benefits,	and	
capabilities	of	the	CODA	System.	This	product	is	not	designed,	intended	or	authorized	for	use	in	human	
applications.	
	
Contact	Information	 	
Kent	Scientific	Corporation	 	 	 Toll-Free:	888-5RATTUS	(888-572-8887)	
1116	Litchfield	Street	 	 	 	 Outside	US:	860-626-1172	
Torrington,	Connecticut		06790	 	 	 Fax:	860-626-1179	
E-mail:	sales@kentscientific.com	 	 	 Internet:	www.kentscientific.com	
	
Disclaimer	
Kent	Scientific	Corporation	makes	no	representations	or	warranties,	expressed,	statutory	or	implied,	
regarding	the	fitness	or	merchantability	of	the	components	of	this	system	for	any	particular	purpose.	
Further,	Kent	Scientific	Corporation	is	not	liable	for	any	damages,	including	but	not	limited	to,	lost	
profits,	lost	savings,	or	other	incidental	or	consequential	damages	arising	from	ownership	or	use	of	
these	products,	or	for	any	delay	in	the	performance	of	its	obligations	under	the	warranty	due	to	causes	
beyond	its	control.	In	no	case	shall	Kent	Scientific	Corporation's	financial	obligation	extend	beyond	the	
cost	of	or	replacement	of	the	Kent	product	in	question.	Kent	Scientific	Corporation	also	reserves	the	
right	to	make	any	improvements	or	modifications	to	these	products	described	in	this	manual	at	any	
time,	without	notice	of	these	changes.	All	brand	and	product	names	used	in	this	manual	are	the	
trademarks	of	their	respective	owners.	
	
Product	Warranty	
The	CODA	System	has	a	one	(1)	year	warranty	including	all	parts	and	labor	charges.	This	warranty	does	
not	cover	damage	by	any	cause	including,	but	not	limited	to,	any	malfunction,	defect	or	failure	caused	
by	or	resulting	from	unauthorized	service	or	parts,	improper	maintenance,	operation	contrary	to	
furnished	instructions,	shipping	or	transit	accidents,	modifications	or	repair	by	the	user,	harsh	
environments,	misuse,	neglect,	abuse,	accident,	incorrect	line	voltage,	fire,	flood,	other	natural	
disasters,	or	normal	wear	and	tear.	Changes	or	modifications	not	approved	by	Kent	Scientific	
Corporation	could	void	the	warranty.	The	foregoing	is	in	lieu	of	all	other	expressed	warranties.	Kent	
Scientific	Corporation	does	not	assume	or	authorize	any	party	to	assume	for	it	any	other	obligation	or	
liability.	
	
Satisfaction	Guarantee	
Should	you	experience	difficulty	with	the	CODA	System,	our	Technical	Support	Group	will	assist	you	in	
trouble-shooting	and	determining	if	the	product	needs	to	be	returned	to	our	facility.	We	will	issue	you	a		
Return	Manufacturer	Authorization	(RMA)	number	before	the	product	is	shipped	back	for	repair.	It	is	at	
the	discretion	of	the	manufacturer	to	replace	or	repair	a	defective	part	or	product.	Please	call	Customer	
Service	(see	numbers	above)	to	obtain	a	Return	Manufacturer	Authorization	number	and	a	
Decontamination	Verification	Form.	Shipments	without	a	RMA	number	will	not	be	accepted.	Prior	to	
shipment,	please	clean	and	decontaminate	the	product	of	any	chemical,	biological,	or	isotopic	
contamination	and	include	a	completed	Decontamination	Verification	Form	with	the	shipment.	
	
Please	note	that	after	our	30-day	return	policy	period	ends,	we	will	be	happy	to	assist	you	with	your	
application,	but	cannot	issue	any	credit	or	refund	for	a	returned	CODA.	 	
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System	Specifications	
	
CODA	Controller	

Voltage 18 VDC, 1.67 amps 
Current Draw 500mA 
Max. O-Cuff Pressure 300mmHg (factory set at 250mmHg) 
Max. VPR Cuff Pressure 200mmHg 
Connection USB 
Dimensions 20.3cmW x 8.9cmH x 19.1cmD 
Weight 3.5kg 

	
Power	Supply	

Input 100 to 240 V 
Output 18 VDC, 1.67 amps 
Input Current 1A (RMS) Max. @ 115 VAC, 0.5A (RMS) Max. @ 230 VAC 
Input Connector Standard IEC 60320 
Output Connector (DC) 2.1mm x 5mm Center Position, Standard  

	
Animal	Holders	

Mouse Holders Small Medium Large 
Weight Range 10 to 25g 25 to 50g 50 to 75g 
Restraining Height 25mm 30mm 37mm 
Max. Restraining Length 108mm 128mm 152mm 
Min. Restraining Length 33mm 43mm 54mm 
Rat Holders Small Medium Large X-Large 
Weight Range 75 to 200g 200 to 300g 300 to 500g 500g+ 
Restraining Height 50mm 62mm 75mm 88mm 
Max. Restraining Length 254mm 285mm 311mm 330mm 
Min. Restraining Length 90mm 109mm 130mm 134mm 

 

Animal Warming Platform 
Platform Size 50cmL x 39.37cmW x 5.08cmH 
Power DC12V, 25W 

	
Infrared	Thermometer	

Recommended Operating Temperature 32° to 104°F / 0° to 40°C -20° to 300°C with 0.1°C res. 
Measuring Range - 4° to 572°F with 0.1°F res. 
Distance to Beam Ratio 5:1 
Battery 4 LR44 Alkaline Button Cells 
Dimensions 5.6cmW x 10.2cmH x 1.9cmD 
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Cleaning	and	Decontamination	
	
Do	not	use	any	alcohol	or	abrasive	detergents	unless	specifically	instructed	otherwise. 

CODA	Controller:		
Position	the	Controller	away	from	areas	of	potential	contamination.	Should	the	controller	become	
soiled,	gently	spot	clean	with	a	damp	wipe	or	towel.	Never	use	liquids	directly	on	the	controller	box.	
	
CODA	Platform,	Animal	Warming	Platform	and	Animal	Holders:	
Clean	gently	with	a	germicidal	or	antiseptic	soap	and	water.	Do	not	use	organic	solvents	or	concentrated	
alcohols.		
	
Occlusion	and	VPR	Cuffs:		
Rinse	gently	with	water	or	clean	gently	with	a	germicidal	or	antiseptic	soap	and	water.	Do	not	use	
organic	solvents	or	concentrated	alcohols.		
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Troubleshooting	
If	you	are	having	difficulty	with	your	CODA	system,	or	would	simply	like	to	view	additional	information	
about	using	it,	you	can	refer	to	material	in	these	sections:	
	

£ Quick	Start	Guide	
Reproduced	here	for	your	convenience	

	
£ Cuff	Testing	Instructions		

How	to	test	for	possible	leaks	
	

£ Calibration	Verification	Kit	Instructions	
What	to	do	if	you	suspect	your	system	to	be	out	of	calibration	

	
£ Return	Procedure	

Information	about	returning	your	controller	for	replacement	or	repair	
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CODA Quick Start Guide																																																																															08/11/14 
	

1. Check	that	the	CODA	system	is	connected	properly	to	a	suitable	computer:	

• The	connection	must	be	via	USB	cable.		

• CODA	software	version	4.0	or	later	supports	either	32	bit	or	64	bit	computers.	

• CODA	software	3.0	or	earlier	supports	only	32	bit	computers	which	must	run	Windows	7	or	XP.		

2. Set	the	warming	platform	to	level	3.	The	default	level	is	2;	press	the	UP	button	to	go	to	level	3.	

3. Temporarily	cover	the	warming	platform	with	the	CODA	cover	to	retain	the	warmth.	

4. Check	all	cuff	bladders	and	replace	any	bladder	that	is	starting	to	yellow	or	crack.	

5. Place	the	animal	into	the	holder.	Move	the	nose	cone	close	enough	to	the	back	of	the	holder	to	
prevent	the	animal	from	turning	around.	You	can	adjust	the	nose	cone	after	you	place	the	back	of	
the	holder	onto	the	animal.	Make	sure	the	animal	is	snug	in	the	holder	and	cover	the	animal’s	tail	
area	with	the	CODA	cover.		

6. Place	an	O-Cuff	on	the	animal’s	tail	and	slide	it	upward,	positioning	it	as	close	to	the	tail	base	as	
possible	without	using	force.	If	the	cuff	begins	to	feel	tight	at	about	¾	of	the	way	toward	the	tail	
base,	try	an	O-Cuff	one	size	up,	if	available.	A	cuff	that	fits	properly	will	slide	freely	but	fit	closely	
when	not	pressurized.	If	no	cuff	is	available	that	fits	your	animal	properly,	please	contact	Kent	
Scientific.			

7. Repeat	step	6	with	a	VPR	cuff.	The	VPR	cuff	should	slide	easily	behind	the	O-Cuff	and	should	be	
placed	close	to	the	O-Cuff	but	does	not	need	to	touch	it.	Note:	Needing	to	size	up	the	O-Cuff	in	step	
6	does	not	necessarily	mean	you	need	to	do	the	same	with	the	VPR	cuff.		

8. Set	up	the	CODA	software	to	perform	5	acclimation	cycles	and	20	regular	cycles	with	a	deflation	
time	set	to	20	seconds.		

9. Before	you	start	measurements,	lift	the	CODA	cover	and	measure	the	animal’s	tail	temperature	by	
pointing	the	infrared	thermometer	at	the	tail’s	base.	The	temperature	should	be	between	32	and	
35°C.	Do	not	start	the	experiment	If	the	temperature	is	not	at	least	32°C.		

10. During	the	experiment,	watch	the	display	on	the	computer	screen.	If	the	blue	line	drops	sharply	
instead	of	gradually	at	the	beginning	of	the	cycle,	you	probably	have	a	leak	in	the	VPR	cuff	bladder.	
If	the	red	line	drops	precipitously,	you	probably	have	a	leak	in	the	O-Cuff.	See	Sample	Displays	
below.		

• Pause	the	experiment,	change	the	bladder	in	the	cuff	with	the	suspected	leak	and	continue.		

• If	the	problem	persists,	pause	the	experiment,	remove	the	cuff,	place	the	white	cap	on	the	
channel	and	continue.	If	the	display	line	returns	to	normal,	you	need	a	new	cuff.	If	the	problem	
persists	with	the	cap	on,	the	leak	is	internal.	In	that	case,	please	contact	Kent	Scientific	
immediately	for	customer	service.		
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Sample Displays	  

VPR	Cuff	Leaks		
Sample	display	showing	a	leaking	VPR	cuff.	The	top	
channel	shows	a	nearly	horizontal	blue	line,	
indicating	no	leak	in	the	VPR	cuff.	The	bottom	
channel	shows	a	sharp	drop	at	the	beginning	of	the	
cycle,	indicating	a	probable	VPR	cuff	leak.	Notice	the	
red	line	for	the	O-Cuff	drops	smoothly	indicating	no	
leak	in	the	O-Cuff.		

O-Cuff	Leaks		
Sample	display	for	O-Cuff	leak.	For	both	channels,	the	red	
line	drops	precipitously	at	the	beginning	of	the	cycle	
indicating	probable	O-Cuff	leaks.	Notice	that	the	blue	line	
for	the	VPR	cuff	remains	close	to	horizontal	indicating	no	
leak	in	the	VPR	cuff.	

O-Cuff	Tests	
Showing	Good	O-Cuff	 	 	 	 																	Showing	O-Cuff	Leak	
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CODA	Cuff	Testing	Instructions	
	

1. Place	caps	tightly	on	all	ports.	

2. Set-up	a	20-cycle	mock	experiment	using	all	available	channels.	

3. Run	the	experiment.	Look	for	these	PASS	or	FAIL	conditions:	

PASS—The	red	line	steps	down	the	graph	at	a	45°	angle	and	the	blue	line	runs	flat,	straight	
across	the	length	of	the	graph.	

FAIL—	The	red	line	drops	to	the	bottom	of	the	graph	or	does	not	step	down	and	the	blue	line	
loses	or	gains	altitude	drastically	OR	the	pump	continues	running	with	no	signal	on	the	
graph	until	an	error	message	appears.	

If	you	detect	any	FAIL	conditions,	contact	Customer	Service	for	further	troubleshooting	
assistance.	Otherwise,	proceed	to	the	next	step.	

4. Pause	the	experiment.	

5. Remove	the	cap	from	the	Channel	1	O-Cuff	port	and	connect	an	Occlusion	Cuff.	

6. Continue	the	experiment.	Look	for	these	PASS	or	FAIL	conditions:	

PASS—The	red	line	steps	down	the	graph	at	a	45°	angle.		

FAIL—	The	red	line	drops	to	the	bottom	of	the	graph	or	does	not	step	down	OR	the	pump	
continues	running	with	no	signal	on	the	graph	until	an	error	message	appears.	

If	you	detect	any	FAIL	conditions,	check	for	cracks	in	the	cuff	body	and/or	tubing.	If	there	are	no	
visible	cracks,	replace	the	bladder	and	re-test.	If	there	are	visible	cracks,	call	Customer	Service	to	
purchase	a	replacement.	Otherwise,	proceed	to	the	next	step.	

7. Pause	the	experiment.	

8. Replace	the	cap	on	the	O-Cuff	port.	Remove	the	cap	from	the	Channel	1	VPR	port	and	connect	a	
VPR	Cuff.	

9. Continue	the	experiment.	Look	for	these	PASS	or	FAIL	conditions:	

PASS—The	blue	line	shows	a	gradual	dip	and	runs	across	the	length	of	the	graph.	

FAIL—	The	blue	line	loses	or	gains	altitude	drastically	OR	the	pump	continues	running	with	no		
signal	on	the	graph	until	an	error	message	appears.	

If	you	detect	any	FAIL	conditions,	check	for	cracks	in	the	cuff	body	and/or	tubing.	If	there	are	no	
visible	cracks,	replace	the	bladder	and	re-test.	If	there	are	visible	cracks,	call	Customer	Service	to	
purchase	a	replacement.	

	
Check	additional	cuffs	using	this	same	procedure	on	the	Channel	1	O-Cuff	and	VPR	ports.	Check	the	rest	
of	the	channels	using	the	outlined	procedure	with	a	set	of	known	good	cuffs.	
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Calibration	Verification	Kit	Instructions	
Ordinarily,	these	instructions	accompany	the	CODA	Calibration	Verification	Kit.	You	can	order	this	Kit	
from	Kent	Scientific	or	can	use	your	own	manometer	and	suitable	tubing	with	fitting	and	follow	these	
instructions.		
	

Contents	
1	manometer	
1	length	of	tubing	with	fitting	

	

Instructions	
1. Start	a	test	experiment,	including	one	session	with	at	least	three	cycles	for	each	channel	to	be	

tested.	Make	sure	all	channels	(ports)	are	closed.		
	

2. Before	running	the	experiment,	connect	the	tubing	attached	to	the	manometer	to	the	O-cuff	
channel	you	are	testing.		

	
3. Make	sure	all	other	channels	are	closed,	using	the	caps	included	with	the	system.	

	
4. Confirm	that	the	thumb	valve	is	closed	on	the	manometer.	

	
5. Start	the	experiment.	Initially,	the	manometer	will	pressurize	to	at	least	250mmHg.	The	

pressure	should	then	bleed	incrementally,	reaching	0mmHg	in	about	15	seconds.	
	

6. Remove	the	manometer	tubing	from	the	O-cuff	and	completely	close	the	O-cuff	port	using	the	
caps	included	with	the	system.		

	
7. Connect	the	manometer	tubing	to	the	VPR	port	of	the	channel	you	are	testing.	

	
8. On	the	next	complete	measurement,	the	manometer	should	pressurize	to	at	least	200mmHg,	

drop	immediately	to	0mmHg	and	re-pressurize	to	approximately	30mmHg.	The	pressure	should	
hold	at	30mmHg	for	a	few	seconds	and	then	drop	to	0mmHg.	

	
Note:	For	multi-channel	systems,	testing	the	O-cuff	on	Channel	1	tests	all	of	the	O-cuff	ports	since	

they	are	connected	internally.	You	should,	however,	test	each	individual	VPR	port	
independently.	

	

Results	
If	your	results	in	steps	5	and	8	are	within	the	expected	range,	your	CODA	system	is	set	to	the	
manufacturer’s	suggested	calibration	guidelines.	If	you	see	channel,	pressure	or	timing	parameters	
different	from	those	mentioned	in	steps	5	or	8,	your	CODA	system	may	need	re-calibrating.	Please	
contact	your	local	Kent	Scientific	representative.		
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Return	Procedure	
Should	you	experience	difficulty	with	the	CODA	System,	our	Technical	Support	Group	will	assist	you	in	
trouble-shooting	and	determining	if	the	product	needs	to	be	returned	to	our	facility.		

If	a	return	is	necessary,	we	will	issue	you	a	Return	Manufacturer	Authorization	(RMA)	number	before	
the	product	is	shipped	back	for	repair.	It	is	at	the	discretion	of	the	manufacturer	to	replace	or	repair	a	
defective	part	or	product.	Please	call	Customer	Service	(see	page	32	for	numbers)	to	obtain	a	Return	
Manufacturer	Authorization	number	and	a	Kent	Scientific	Decontamination	Form.	Shipments	without	a	
RMA	number	will	not	be	accepted.	

Prior	to	shipment,	please	clean	and	decontaminate	the	product	of	any	chemical,	biological	or	isotopic	
contamination.	Please	include	a	completed	and	signed	Kent	Scientific	Decontamination	Form	with	the	
shipment.	See	page	34	for	cleaning	instructions.	

Please	see	CODA	Pre-Return	Procedure	on	the	next	page.		
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